


ÓÄÊ 004.4(075.4)
ÁÁÊ 32.973.26

À 31

Ïåðåâîä ñ àíãëèéñêîãî Ì. À. Ðàéòìàíà

Adobe Photoshop CC. Classroom in a book
Authorized translation from the English language edition, entitled ADOBE PHOTOSHOP CC CLASSROOM 

IN A BOOK; ISBN 0321928075; by ADOBE CREATIVE TEAM; published by Pearson Education, Inc, 
publishing as Adobe Press. Copyright © 2013 by Adobe Systems, Inc.  All rights reserved. 

No part of this book may be reproduced or transmitted in any form or by any means, electronic or mechanical, 
including photocopying, recording or by any information storage retrieval system, 

without permission from Pearson Education, Inc.

Âñå ïðàâà çàùèùåíû. Íèêàêàÿ ÷àñòü íàñòîÿùåãî èçäàíèÿ íè â êàêèõ öåëÿõ íå ìîæåò áûòü âîñïðîèçâåäåíà
â êàêîé áû òî íè áûëî ôîðìå è êàêèìè áû òî íè áûëî ñðåäñòâàìè, áóäü òî ýëåêòðîííûå èëè ìåõàíè÷åñêèå, âêëþ÷àÿ 

ôîòîêîïèðîâàíèå è çàïèñü íà ìàãíèòíûé íîñèòåëü, åñëè íà ýòî íåò ïèñüìåííîãî ðàçðåøåíèÿ
 ïðàâîîáëàäàòåëÿ Pearson Education, Inc.

Adobe Photoshop CC. Îôèöèàëüíûé ó÷åáíûé êóðñ ; [ïåð. ñ àíãë. 
Ì. À. Ðàéòìàíà]. — Ì. : Ýêñìî, 2014. — 456 ñ. + DVD. — (Îôèöèàëüíûé 
ó÷åáíûé êóðñ).

ISBN 978-5-699-68470-0

Ýòî îôèöèàëüíûé ó÷åáíûé êóðñ ïî ïðîãðàììå Adobe Photoshop CÑ, âõîäÿùèé â çíàìå-
íèòóþ ñåðèþ «Classroom in a Book». Êíèãà ïðåäíàçíà÷åíà êàê íà÷èíàþùèì, òàê è îïûòíûì 
ïîëüçîâàòåëÿì, æåëàþùèì ïîëó÷èòü îò Adobe Photoshop CÑ ìàêñèìóì âîçìîæíîãî. Ñåðèè 
ïðîñòûõ, ïðåêðàñíî ïîäîáðàííûõ ïîøàãîâûõ èíñòðóêöèé ïîçâîëÿò âàì íà ïðàêòèêå îñâîèòü 
âñå èíñòðóìåíòû Adobe Photoshop CÑ.

Íà äèñêå ïðåäñòàâëåíû ôàéëû äëÿ óðîêîâ. Ñ èõ ïîìîùüþ âû áûñòðî è ëåãêî ñòàíåòå íà-
ñòîÿùèì ìàñòåðîì ðàáîòû ñ Adobe Photoshop CÑ.

ÓÄÊ 004.4(075.4)
ÁÁÊ 32.973.26

À 31

ISBN 978-5-699-68470-0
© Ðàéòìàí Ì. À., ïåðåâîä íà ðóññêèé ÿçûê, 2014
© Îôîðìëåíèå. ÎÎÎ «Èçäàòåëüñòâî «Ýêñìî», 2014



ОФИЦИАЛЬНЫЙ УЧЕБНЫЙ КУРС ADOBE PHOTOSHOP CC 5

ОГЛАВЛЕНИЕ

 ЧТО НАХОДИТСЯ НА ДИСКЕ  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13

 НАЧАЛО РАБОТЫ . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14

Об официальном учебном курсе Adobe  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14

Что нового в этом издании  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14

Предварительные требования . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15

Установка программы Adobe Photoshop  . . . . . . . . . . . . . . . . . . . . . . . . . . . 15

Запуск программы Adobe Photoshop  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16

Копирование файлов официального учебного курса  . . . . . . . . . . . . . . . . 16

Восстановление установок по умолчанию  . . . . . . . . . . . . . . . . . . . . . . . . . 17

Сохранение текущих настроек цвета  . . . . . . . . . . . . . . . . . . . . . . . . . . . 17

Восстановление настроек цвета  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18

Дополнительные ресурсы  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18

Сертификация Adobe  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19

1 ЗНАКОМСТВО С РАБОЧИМ ПРОСТРАНСТВОМ

Начало работы в программе Adobe Photoshop  . . . . . . . . . . . . . . . . . . . . . 24

Запуск программы Photoshop и открытие файла. . . . . . . . . . . . . . . . . 24

Открытие файла при помощи программы Adobe Bridge . . . . . . . . . . . 27

Использование инструментов  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28

Выбор и использование инструментов из панели Tools . . . . . . . . . . . 28

Выбор и использование скрытых инструментов  . . . . . . . . . . . . . . . . . 31

Редактирование выделенных областей . . . . . . . . . . . . . . . . . . . . . . . . . 32

Настройка инструментов . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35

Использование контекстных меню  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36

Настройка инструментов с помощью панели параметров. . . . . . . . . 37

Использование панелей и их меню. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38

Отмена действий в программе Photoshop. . . . . . . . . . . . . . . . . . . . . . . . . . 40

Отмена одного действия  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41

Отмена нескольких действий  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41

Подробнее о панелях и их размещении . . . . . . . . . . . . . . . . . . . . . . . . . 45



6 ОГЛАВЛЕНИЕ

Свертывание и развертывание панелей . . . . . . . . . . . . . . . . . . . . . . . . 46

Особенности панели Tools и панели параметров. . . . . . . . . . . . . . . . . 47

Настройка рабочего пространства  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47

Поиск ресурсов по работе с программой Photoshop  . . . . . . . . . . . . . . . . 52

Контрольные вопросы  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 54

2 ОСНОВЫ КОРРЕКЦИИ ФОТОГРАФИЙ

Стратегия ретуширования . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58

Организация эффективной последовательности задач . . . . . . . . . . . 58

Настройка процесса в зависимости от цели. . . . . . . . . . . . . . . . . . . . . 58

Разрешение и размер изображений  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 59

Начало работы . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 60

Выпрямление и кадрирование изображений в программе Photoshop . . . . 62

Настройка цвета и тонов изображений . . . . . . . . . . . . . . . . . . . . . . . . . . . . 64

Использование инструмента Spot Healing Brush . . . . . . . . . . . . . . . . . . . . 66

Использование заливок с учетом содержимого  . . . . . . . . . . . . . . . . . . . . 69

Ретуширование с помощью инструмента Clone Stamp . . . . . . . . . . . . . . . 70

Применение заплаток с учетом содержимого  . . . . . . . . . . . . . . . . . . . . . . 72

Настройка резкости изображений  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 74

Превращение фотографии в черно-белую. . . . . . . . . . . . . . . . . . . . . . . 76

Контрольные вопросы  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 78

3 РАБОТА С ВЫДЕЛЕННЫМИ ОБЛАСТЯМИ

О выделенных областях и инструментах выделения . . . . . . . . . . . . . . . . . 82

Начало работы . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 83

Использование инструмента Quick Selection  . . . . . . . . . . . . . . . . . . . . . . . 84

Перемещение выделенных областей  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 85

Управление выделенными областями  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 86

Перемещение границ выделенных областей  . . . . . . . . . . . . . . . . . . . . 86

Перемещение выделенных пикселов с помощью сочетаний 
клавиш . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 88

Перемещение выделенных областей при помощи
клавиш ←, ↑, ↓ и → . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 88

Использование инструмента Magic Wand  . . . . . . . . . . . . . . . . . . . . . . . . . . 90

Создание выделенных областей при помощи инструмента Lasso . . . . . 93

Поворот выделенных областей  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 94

Создание выделенных областей при помощи инструмента 
Magnetic Lasso . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 95



ОФИЦИАЛЬНЫЙ УЧЕБНЫЙ КУРС ADOBE PHOTOSHOP CC 7

Создание выделенных областей от центра . . . . . . . . . . . . . . . . . . . . . . . . . 97

Изменение размеров и копирование выделенных областей . . . . . . . . . 98

Изменение размера содержимого выделенных областей. . . . . . . . . 98

Одновременное перемещение и дублирование выделенных 
областей  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 99

Кадрирование изображений  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .101

Контрольные вопросы  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .103

4 РАБОТА СО СЛОЯМИ

О слоях . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .106

Начало работы . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .106

Использование панели Layers  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .107

Переименование и копирование слоев. . . . . . . . . . . . . . . . . . . . . . . .109

Просмотр отдельных слоев  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .111

Добавление границ слоев . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .112

Управление слоями. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .114

Изменение непрозрачности слоев  . . . . . . . . . . . . . . . . . . . . . . . . . . . .116

Создание дубликатов слоев и изменение режима наложения. . . .116

Изменение размера и поворот слоев. . . . . . . . . . . . . . . . . . . . . . . . . .119

Применение фильтров при создании рисунков  . . . . . . . . . . . . . . . . .120

Добавление новых слоев посредством перемещения  . . . . . . . . . . .122

Добавление текста  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .123

Применение градиента к слоям . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .125

Применение стилей слоев. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .126

Добавление корректирующих слоев. . . . . . . . . . . . . . . . . . . . . . . . . . . . . .131

Обновление эффектов слоев  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .132

Добавление границ слоев. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .134

Сведение слоев и сохранение файлов . . . . . . . . . . . . . . . . . . . . . . . . . . . .135

Контрольные вопросы  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .140

5 КОРРЕКЦИЯ И УЛУЧШЕНИЕ ЦИФРОВЫХ ФОТОГРАФИЙ

Начало работы . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .144

О RAW-файлах  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .147

Обработка файлов в программе Camera Raw  . . . . . . . . . . . . . . . . . . . . .147

Открытие изображений в программе Camera Raw  . . . . . . . . . . . . . .148

Настройка баланса белого  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .149

Настройка оттенков в Camera Raw  . . . . . . . . . . . . . . . . . . . . . . . . . . . .152

Настройка резкости  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .155



8 ОГЛАВЛЕНИЕ

Синхронизация настроек между изображениями . . . . . . . . . . . . . . .156

Сохранение изменений в программе Camera Raw  . . . . . . . . . . . . . .158

Цветокоррекция  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .161

Настройка баланса белого в программе Camera Raw  . . . . . . . . . . .161

Коррекция уровней . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .163

Изменение насыщенности в программе Camera Raw  . . . . . . . . . . .164

Удаление недостатков с помощью инструмента Healing 
Brush. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .165

Улучшение изображений с помощью инструментов Dodge 
и Sponge. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .167

Коррекция тона кожи  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .171

Применение фильтра Surface Blur . . . . . . . . . . . . . . . . . . . . . . . . . . . . .174

Коррекция цифровых фотографий в программе Photoshop  . . . . . . . . .176

Коррекция теней и светов . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .176

Удаление «эффекта красных глаз» . . . . . . . . . . . . . . . . . . . . . . . . . . . . .179

Уменьшение шума . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .180

Коррекция искаженных изображений . . . . . . . . . . . . . . . . . . . . . . . . . . . .182

Добавление глубины резкости. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .185

Добавление объектов с помощью инструмента 
Content-Aware Move. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .188

Добавление интерактивного размытия . . . . . . . . . . . . . . . . . . . . . . . .189

Контрольные вопросы  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .194

6 МАСКИ И КАНАЛЫ

Работа с масками и каналами  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .198

Начало работы . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .198

Создание масок . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .199

Уточнение масок  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .201

Создание быстрых масок. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .206

Манипулирование изображениями с помощью инструмента 
Puppet Warp  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .208

Работа с каналами  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .210

Создание теней с помощью альфа-канала  . . . . . . . . . . . . . . . . . . . . .210

Настройка отдельных каналов  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .213

Контрольные вопросы  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .219



ОФИЦИАЛЬНЫЙ УЧЕБНЫЙ КУРС ADOBE PHOTOSHOP CC 9

7 ОФОРМЛЕНИЕ ТЕКСТА

О тексте  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .222

Начало работы . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .222

Создание обтравочной маски из текста  . . . . . . . . . . . . . . . . . . . . . . . . . .224

Добавление направляющих для размещения текста  . . . . . . . . . . . .224

Добавление точки начала набора . . . . . . . . . . . . . . . . . . . . . . . . . . . . .224

Создание обтравочных масок и применение эффекта тени  . . . . . .225

Создание текста по контуру  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .229

Деформация текста. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .232

Оформление абзацев текста  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .233

Использование направляющих для размещения текста  . . . . . . . . .234

Добавление абзацев текста из комментариев  . . . . . . . . . . . . . . . . .234

Стилизация текста. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .236

Создание стилей абзаца  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .236

Применение стилей абзаца  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .238

Редактирование стилей абзаца . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .239

Создание стилей символа  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .239

Добавление прямоугольников со скругленными краями  . . . . . . . . . . .241

Добавление вертикального текста  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .243

Контрольные вопросы  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .246

8 ТЕХНИКИ РАБОТЫ С ВЕКТОРНЫМИ ОБЪЕКТАМИ

О растровых изображениях и векторной графике. . . . . . . . . . . . . . . . . .250

О контурах и инструменте Pen  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .251

Начало работы . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .251

Создание контуров  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .253

Использование инструмента Pen. . . . . . . . . . . . . . . . . . . . . . . . . . . . . .255

Завершение контуров  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .257

Преобразование выделенных областей в контуры . . . . . . . . . . . . . .258

Преобразование контуров в выделенные области . . . . . . . . . . . . . .260

Преобразование выделенных областей в слои  . . . . . . . . . . . . . . . . .261

Создание векторных объектов для фона . . . . . . . . . . . . . . . . . . . . . . . . . .263

Создание масштабируемых фигур . . . . . . . . . . . . . . . . . . . . . . . . . . . . .263

Сброс выделения с контуров  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .266

Изменение цвета заливки слоев-фигур . . . . . . . . . . . . . . . . . . . . . . . .266

Вычитание фигур из слоев-фигур. . . . . . . . . . . . . . . . . . . . . . . . . . . . . .267

Работа с произвольными фигурами  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .269



10 ОГЛАВЛЕНИЕ

Импорт смарт-объектов. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .274

Добавление текста из файла программы Illustrator  . . . . . . . . . . . . .274

Добавление векторных масок к смарт-объектам  . . . . . . . . . . . . . . .275

Поворот холста (требуется поддержка OpenGL)  . . . . . . . . . . . . . . . . .276

Завершение работы  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .278

Контрольные вопросы  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .281

9 ПРОФЕССИОНАЛЬНЫЕ ПРИЕМЫ СОЗДАНИЯ КОМПОЗИЦИЙ

Начало работы . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .284

Организация слоев . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .286

Использование смарт-фильтров  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .288

Применение фильтра Liquify  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .288

Позиционирование остальных слоев  . . . . . . . . . . . . . . . . . . . . . . . . . .290

Редактирование смарт-фильтров  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .291

Рисование на слоях. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .292

Добавление фона  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .294

Автоматизация многоэтапных задач  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .296

Запись операций . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .296

Воспроизведение операций . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .300

Копирование и уточнение операций. . . . . . . . . . . . . . . . . . . . . . . . . . .301

Создание условных операций. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .303

Пакетное применение операций . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .304

Масштабирование изображения с низким разрешением. . . . . . . . . . .306

Сохранение изображений для четырехцветной печати  . . . . . . . . . . . . .309

Сопоставление цветовых схем нескольких изображений. . . . . . . . . . .310

Создание панорамы . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .314

Финальные штрихи  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .317

Использование фильтра Adaptive Wide Angle  . . . . . . . . . . . . . . . . . . .317

Добавление фотофильтров  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .318

Подготовка файлов для публикации во Всемирной паутине. . . . . .320

Контрольные вопросы  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .322

10 ОБРАБОТКА ВИДЕОРОЛИКОВ

Начало работы . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .326

Создание новых видеопроектов  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .327

Создание проектов . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .327

Импорт файлов. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .328

Изменение продолжительности роликов на Шкале времени . . . . .330



ОФИЦИАЛЬНЫЙ УЧЕБНЫЙ КУРС ADOBE PHOTOSHOP CC 11

Анимация текста с помощью ключевых кадров . . . . . . . . . . . . . . . . . . . .332

Создание эффектов  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .335

Добавление корректирующих слоев в видеоролики. . . . . . . . . . . . .335

Анимация эффекта изменения масштаба  . . . . . . . . . . . . . . . . . . . . . .336

Наложение смарт-фильтров на видеоролики  . . . . . . . . . . . . . . . . . . .337

Анимация эффектов стиля. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .339

Анимация изображений и создание эффекта движения  . . . . . . . . .341

Добавление эффектов панорамирования и масштабирования . . . .342

Добавление переходов  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .342

Добавление звука. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .344

Приглушение нежелательного шума. . . . . . . . . . . . . . . . . . . . . . . . . . . . . .345

Просчет видеопроектов . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .346

Контрольные вопросы  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .348

11 РИСОВАНИЕ С ПОМОЩЬЮ МИКС-КИСТИ

Об инструменте Mixer Brush  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .352

Начало работы . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .352

Выбор параметров кисти. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .353

Настройка параметров влажности кисти. . . . . . . . . . . . . . . . . . . . . . .354

Использование размываемых кончиков кистей  . . . . . . . . . . . . . . . .357

Смешивание цветов . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .358

Создание пользовательских предустановок кисти  . . . . . . . . . . . . . . . . .362

Смешивание красок и изображения  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .363

Контрольные вопросы  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .370

12 РАБОТА С ТРЕХМЕРНЫМИ ОБЪЕКТАМИ

Начало работы . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .374

Создание трехмерной фигуры из слоя  . . . . . . . . . . . . . . . . . . . . . . . . . . . .375

Управление трехмерными объектами  . . . . . . . . . . . . . . . . . . . . . . . . . . . .376

Добавление трехмерных объектов . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .379

Создание трехмерной открытки . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .379

Создание трехмерной сетки из нового слоя  . . . . . . . . . . . . . . . . . . . .380

Импорт трехмерных объектов из файлов  . . . . . . . . . . . . . . . . . . . . . .381

Создание трехмерного текста. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .382

Слияние трехмерных слоев в одном трехмерном пространстве  . . . . .383

Позиционирование объектов на сцене  . . . . . . . . . . . . . . . . . . . . . . . . . . .385

Изменение ракурса камеры . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .385

Перемещение объектов с помощью виджета 3D Axis . . . . . . . . . . . .386



12 ОГЛАВЛЕНИЕ

Использование панели Properties для позиционирования 
3D-объектов  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .388

Масштабирование и поворот объектов с помощью виджетов . . . .390

Применение материалов к 3D-объектам. . . . . . . . . . . . . . . . . . . . . . . . . .392

Изменение внешнего вида трехмерного текста. . . . . . . . . . . . . . . . .392

Применение материалов к объектам . . . . . . . . . . . . . . . . . . . . . . . . . .395

Освещение трехмерной сцены. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .399

Рендеринг трехмерной сцены  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .401

Контрольные вопросы  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .405

13 ПОДГОТОВКА ФАЙЛОВ ДЛЯ ВСЕМИРНОЙ ПАУТИНЫ

Начало работы . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .408

Создание фрагментов  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .412

Выделение фрагментов и установка свойств фрагментов  . . . . . . .412

Создание кнопок навигации. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .414

Создание фрагментов на основе слоев . . . . . . . . . . . . . . . . . . . . . . . .417

Экспорт HTML-страниц и изображений  . . . . . . . . . . . . . . . . . . . . . . . . . . .419

Использование функции Zoomify. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .426

Контрольные вопросы  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .431

14 ПЕЧАТЬ И УПРАВЛЕНИЕ ЦВЕТОМ

Об управлении цветом. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .434

Начало работы . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .436

Настройки управления цветом. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .436

Цветопробы  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .437

Определение цветов, не входящих в гамму  . . . . . . . . . . . . . . . . . . . . . . .440

Настройка изображений и пробная печать. . . . . . . . . . . . . . . . . . . . . . . .441

Сохранение изображений в файлы формата EPS в режиме CMYK  . . . .444

Вывод на печать  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .445

Контрольные вопросы  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .447

ПРИЛОЖЕНИЕ. ОБЗОР ПАНЕЛИ TOOLS  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 448

ПРЕДМЕТНЫЙ УКАЗАТЕЛЬ  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 452



24 УРОК 1 Знакомство с рабочим пространством

Начало работы в программе Adobe Photoshop

Рабочее пространство Adobe Photoshop включает в себя строку меню, па-
нели быстрого доступа к различным инструментам, а также панели для 
редактирования и внесения элементов в изображение. Вы можете добав-
лять в меню команды и фильтры, устанавливая плагины .

Программа Photoshop предоставляет возможность работать с растровой 
графикой (так называются изображения, состоящие из маленьких ква-
дратных элементов — пикселов), а также с векторной графикой. Вектор-
ные рисунки состоят из линий, сохраняющих четкость при различном 
масштабировании. В программе Photoshop можно создавать изображе-
ния с нуля или обрабатывать импортированные из других источников, 
например:

• фотографии с цифровой камеры;

• цифровые изображения с компакт-дисков;

• сканированные фотографии, пленки, негативы, графику или другие 
документы;

• кадры, захваченные из видеороликов;

• художественные работы, созданные в графических редакторах.

Запуск программы Photoshop и открытие файла

Для начала запустите программу Adobe Photoshop и восстановите на-
стройки по умолчанию.

1 На рабочем столе дважды щелкните мышью по ярлыку программы 
Adobe Photoshop, чтобы открыть ее, а затем незамедлительно нажми-
те и удерживайте сочетание клавиш Ctrl+Alt+Shift (Windows) или 
Command+Option+Shift (OS X), чтобы восстановить настройки по 
умолчанию.

Если на рабочем столе ярлык программы Photoshop отсутствует, вы-
полните команду меню Start ⇒ All programs ⇒ Adobe Photoshop CC 
(Пуск ⇒ Все программы ⇒ Adobe Photoshop CC) (Windows), откройте 
папку Applications (Приложения) или взгляните на док (OS X), чтобы 
найти значок программы. 

2 В появившемся диалоговом окне щелкните мышью по кнопке Yes 
(Да), чтобы подтвердить, что вы хотите восстановить установки по 
умолчанию.

• Примечание. 

Как правило, во время 
работы с собственны-
ми проектами вам не 
понадобится возвра-
щаться к настройкам 
по умолчанию. Однако 
перед началом выпол-
нения каждого урока 
этой книги вам не-
обходимо восстанавли-
вать установки, чтобы 
результат на вашем 
экране точно совпадал 
с приведенными опи-
саниями. Более под-
робную информацию 
см. в разделе «Восста-
новление установок по 
умолчанию».
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На экране появится рабочая среда программы Photoshop, показанная на 
следующей иллюстрации.
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По умолчанию рабочее пространство программы Photoshop состоит из 
строки меню и панели параметров в верхней части экрана, панели Tools 
(Инструменты) в левой части окна и нескольких открытых панелей 
в доке справа. При открытии документов появляется одно или несколько 
окон изображений, и вы можете просматривать их одновременно благо-
даря интерфейсу с вкладками.  Пользовательский интерфейс програм-
мы Photoshop схож с интерфейсами Adobe Illustrator®, Adobe InDesign® 
и Adobe Flash®. Это значит, что, научившись обращаться с инструмента-
ми и панелями одного из них, вы легко сможете работать и в других про-
граммах корпорации Adobe.

Существует одно главное отличие между рабочими пространствами про-
граммы Photoshop в операционных системах Windows и OS X: в Windows 
программа Photoshop всегда запускается в отдельном окне. В OS X вы 
можете работать с фреймом приложения, который объединяет все окна 
и панели программы Photoshop в пределах границ, отличных от фреймов 
других открытых вами программ. За пределами фрейма приложения на-
ходится только строка меню. По умолчанию фрейм приложения  включен. 
Чтобы отключить его, следует выбрать команду меню Window ⇒ Appli-
cation Frame  (Окно ⇒ Фрейм приложения).

• Примечание. 

На иллюстра ции при-
ведена версия окна 
программы Photoshop 
для операционной 
системы Windows. 
В операционной систе-
ме OS X расположение 
элементов интерфейса 
идентично. Однако 
стиль оформления 
в различных операци-
онных системах может 
варьироваться. 

А. Строка меню
Б. Панель параметров 
инструмента
В. Панель Tools (Инст-
рументы)
Г. Вкладка панели Mini 
Bridge

Д. Вкладка панели Time-
line (Шкала времени)
Е. Переключатель рабо-
чей среды
Ж. Панели
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В операционной системе OS X фрейм приложения объединяет окно документа, панели 
и строку меню

3 Выполните команду меню File ⇒ Open (Файл ⇒ Открыть) и перей-
дите к папке Lessons\Lessons01, скопированной с DVD-диска книги 
на жесткий диск вашего компьютера.

4 Выберите файл 01End.psd и щелкните мышью по кнопке Open (От-
крыть). Кликните по кнопке OK, если появится диалоговое окно 
с предупреждением о несовпадении встро-
енного профиля.

Файл 01End.psd откроется в окне изображе-
ния. В итоговых файлах (с окончанием End 
в имени файла) вы всегда можете просмотреть 
результат выполнения упражнений каждого 
урока. В этом проекте вы закончите дизайн 
обложки книги.

5 Выберите команду меню File ⇒ Close 
(Файл ⇒ Закрыть) или щелкните мышью 
по кнопке Close (Закрыть) в строке заго-
ловка окна изображения. (При этом не за-
вершайте работу программы Photoshop.)
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Открытие файла при помощи программы Adobe Bridge

Изучая книгу, вы в каждом уроке будете открывать разные файлы. Вы 
можете скопировать эти файлы, сохранив их под новыми именами в лю-
бой удобной для вас папке, или работать с оригинальными файлами, а за-
тем, если захотите выполнить урок заново, вы снова можете скопировать 
их с диска.

В предыдущем упражнении вы выполняли команду Open (Открыть), 
чтобы открыть файл. Теперь мы откроем другой файл, используя Adobe 
Bridge , программу просмотра файлов, которая упрощает поиск изобра-
жений.

1 Выполните команду меню File ⇒ Browse in Bridge (Файл ⇒ Обзор 
в Bridge). В появившемся диалоговом окне нажмите кнопку OK. 

Откроется окно Adobe Bridge с набором панелей, меню и элементов 
управления.

2 На панели Folders (Папки) в левом верхнем углу программы перей-
дите в папку Lessons, которую вы ранее скопировали с DVD-диска 
книги на жесткий диск компьютера. Содержимое папки Lessons ото-
бразится на панели Content (Содержимое).

3 Выделите папку Lessons, а затем выполните команду меню File ⇒ Add 
To Favorites (Файл ⇒ Добавить в избранное). Добавляя на панель 
Favorites (Избранное) файлы, папки, ярлыки приложений и прочие 
материалы, вы тем самым обеспечиваете быстрый доступ к ним. 

4 Выберите вкладку Favorites (Избранное). В открывшейся панели 
Favorites (Избранное)  щелкните мышью по папке Lessons. Затем на 
панели Content (Содержимое) дважды щелкните мышью по папке 
Lesson01.

• Примечание. 
Если программа Bridge 
не установлена, вам 
будет предложено 
установить ее, когда 
вы выберете команду 
меню Browse in Bridge 
(Обзор в Bridge).
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Миниатюры содержащихся в папке файлов отобразятся на панели Con-
tent (Содержимое).

5 На панели Content (Содержимое) дважды щелкните мышью по ми-
ниатюре файла 01Start.psd, чтобы открыть его, или выделите миниа-
тюру и выполните команду меню File ⇒ Open (Файл ⇒ Открыть).

Изображение 01Start.psd откроется в программе Photoshop. Вы можете 
оставить окно программы Bridge открытым или закрыть его; на этом уро-
ке оно вам не понадобиться.

Использование инструментов

В программу Photoshop интегрирован набор инструментов, позволяю-
щих создавать графические изображения для вывода на печать, разме-
щения во Всемирной паутине и просмотра с мобильных устройств. Мы 
легко могли бы создать огромный талмуд с детальным описанием все-
го богатства инструментов программы Photoshop и их настроек. Такая 
информация, бесспорно, была бы полезна, но не она — основная цель 
данной книги. Вместо подробного знакомства со всем инструментарием 
Photoshop вы будете приобретать опыт, настраивая и используя лишь не-
которые инструменты на уроках. В каждом уроке мы станем знакомить 
вас с новыми инструментами и способами их применения. Завершив все 
упражнения, вы сформируете фундамент для дальнейшего самостоятель-
ного изучения инструментов и возможностей программы Photoshop.

Выбор и использование инструментов из панели Tools

Tools (Инструменты) — это длинная узкая панель у левого края рабочей 
области, на которой расположены инструменты для выделения, рисова-
ния и редактирования, элементы управления для выбора основного и фо-
нового цветов, а также для просмотра изображений.



ОФИЦИАЛЬНЫЙ УЧЕБНЫЙ КУРС ADOBE PHOTOSHOP CC 29

Начнем с использования инструмента Zoom (Масштаб), который имеет-
ся во многих других программах корпорации Adobe, включая Illustrator, 
InDesign и Acrobat. 

1 Щелкните мышью по кнопке с двойной стрелкой прямо над панелью 
Tools (Инструменты), чтобы панель отобразилась в виде двух коло-
нок. Вновь щелкните по стрелке, чтобы вернуться в режим одной 
колонки — это позволяет использовать экранное пространство более 
эффективно. 

2 Проверьте строку состояния в нижней части рабочей области (Win-
dows) или окна изображения (OS X) и обратите внимание на про-
центные значения слева. Они отображают текущий уровень увеличе-
ния изображения (уровень масштаба). 

3 Установите указатель мыши поверх панели Tools (Инструменты) 
и удерживайте поверх кнопки с увеличительным стеклом до тех пор, 
пока не появится подсказка. Подсказка содержит название инстру-
мента (Zoom (Масштаб)) и клавишу быстрого доступа к нему на кла-
виатуре (Z). 

Zoom level Status barУровень масштаба Строка состояния

4 На панели Tools (Инструменты) щелкните мышью по инструменту 
Zoom (Масштаб) ( ) или нажмите клавишу Z, чтобы выбрать этот 
инструмент.

5 Установите указатель мыши в окне изображения. Теперь указатель 
мыши выглядит как миниатюрная лупа со знаком «плюс» в центре 
стекла ( ).

6 Щелкните мышью в любом месте окна изображения.

Изображение увеличится на предустановленное число процентов, преж-
нее значение масштаба в строке состояния при этом изменится. Позиция, 
по которой вы щелкнули инструментом Zoom (Масштаб), будет нахо-
диться в центре увеличенного изображения. Если вы опять щелкнете 
мышью, масштаб изменится с заданным шагом еще раз. Максимальное 
значение увеличения — 3200%. 

7 Нажмите и удерживайте клавишу Alt (Windows) или Option (OS X), 
чтобы в центре указателя инструмента Zoom (Масштаб) появился 
знак «минус» ( ), а затем щелкните в любой позиции изображения. 
Отпустите клавишу Alt или Option.

• Примечание. 

Полный  список инстру-
ментов панели Tools 
(Инструменты) приво-
дится в приложении 
в конце этой книги.
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Вы увидите, что изображение уменьшилось на заданную величину. Те-
перь можете увидеть бо́льший участок изображения, но меньше деталей.

8 Установите на панели параметров флажок Scrubby Zoom (Масшта-
бирование перетаскиванием), а затем, нажав и удерживая кнопку 
мыши в любой позиции изображения, перетащите указатель мыши 
вправо. Изображение увеличится. Для уменьшения масштаба пере-
тащите указатель влево.  

Параметр Scrubby Zoom (Масштабирование перетаскиванием) досту-
пен, если в диалоговом окне Preferences (Установки) установлен фла-
жок Use Graphics Processor (Использовать графический процессор). 
Выполните команду меню Edit ⇒ Preferences ⇒ Performance (Редак-
тирование ⇒ Установки ⇒ Производительность) (Windows) или Pho-
toshop ⇒ Preferences ⇒ Performance (Photoshop ⇒ Установки ⇒ Про-
изводительность) (OS X), чтобы открыть диалоговое окно Preferences 
(Установки).

9 На панели параметров сбросьте флажок Scrubby Zoom (Масштаби-
рование перетаскиванием). Затем инструментом Zoom (Масштаб) 
нарисуйте прямоугольник вокруг овальной картины, захватывая 
и красные перекрестия.

Изображение увеличится таким образом, что фрагмент, находящийся 
в прямоугольнике, заполнит все окно изображения.

Итак, вы научились использовать четыре метода, позволяющие изменять 
масштаб отображения документа с помощью инструмента Zoom (Мас-
штаб): щелкая мышью, удерживая клавиши клавиатуры при щелчке мы-
шью, перетаскивая указатель мыши для увеличения или уменьшения 
масштаба и перетаскивая указатель мыши для указания области, подле-
жащей масштабированию. Сочетания клавиш существуют и для многих 
других инструментов панели Tools (Инструменты). Вы будете пользо-
ваться ими в следующих уроках книги.

• Примечание. 

Для увеличения или 
уменьшения масштаба 
изображения исполь-
зуют и другие методы. 
Например, если вы-
бран инструмент Zoom 
(Масштаб), вы можете 
установить режим 
Zoom In (Увеличение) 
или Zoom Out (Умень-
шение) на панели пара-
метров. Также можно 
выбрать команду меню 
View ⇒ Zoom In (Про-
смотр ⇒ Увеличить) 
или View ⇒ Zoom Out 
(Просмотр ⇒ Умень-
шить) или ввести 
уровень масштабиро-
вания в строке состоя-
ния и нажать клавишу 
Enter (или Return).
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Выбор и использование скрытых инструментов

Программа Photoshop располагает многими инструментами для редак-
тирования изображений. Однако вы, вероятно, будете одновременно 
работать лишь с частью из них. Некоторые инструменты панели Tools 
(Инструменты) сгруппированы. Причем для каждой группы на панели 
отображается только один инструмент, а остальные спрятаны за ним.

Маленький треугольник в правом нижнем углу кнопки — это индикатор, 
сообщающий, что на данной кнопке доступны и другие, скрытые, инстру-
менты.

1 Установите указатель мыши поверх второго сверху инструмента пане-
ли Tools (Инструменты) и удерживайте его до появления подсказки. 
В подсказке вы увидите название данного инструмента — Rectangu-
lar Marquee (Прямоугольная область) ( ) и его «горячую» клавишу 
(M) на клавиатуре. Выберите этот инструмент.

2 Выберите инструмент Elliptical Marquee (Овальная область) ( ), 
скрытый за инструментом Rectangular Marquee (Прямоугольная об-
ласть), при помощи одного из следующих методов: 

• нажмите и удерживайте кнопку 
мыши, установив указатель по-
верх инструмента Rectangular 
Marquee (Прямоугольная об-
ласть), пока не появится рас-
крывающийся список скрытых 
инструментов, из которого вы-
берите пункт Elliptical Marquee 
(Овальная область);

• нажав и удерживая клавишу Alt (Windows) или Option (OS X), 
на панели Tools (Инструменты) щелкните по кнопке уже выбран-
ного инструмента Elliptical Marquee (Овальная область), чтобы 
просмотреть скрытые в этой группе инструменты;

• нажмите сочетание клавиш Shift+M — оно позволяет переклю-
чаться между инструментами Rectangular Marquee (Прямоу-
гольная область) и Elliptical Marquee (Овальная область).

3 Установите указатель мыши в окне изображения на красное перекре-
стие в левой части около портрета.

Так как выбран инструмент Elliptical Marquee (Овальная область), ука-
затель примет форму перекрестия (+).

4 Удерживая нажатой кнопку мыши, перетащите указатель по портре-
ту вниз и вправо, чтобы нарисовать эллипс вокруг портрета, а затем 
отпустите кнопку мыши.
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Анимированная пунктирная линия 
означает, что область внутри нее вы-
делена. Выделенная область является 
единственным пространством в преде-
лах изображения, которое можно редак-
тировать.

Различные способы выделения и пере-
мещения выделенной области вы под-
робнее изучите в уроке 3.

Редактирование выделенных областей

Как правило, вы вносите изменения в пределах 
выделенной области. Но в этом проекте вам нуж-
но изменить цвет обоев, не влияя на портрет. Что-
бы сделать это, нужно инвертировать выделение 
так, чтобы все изображение, кроме портрета, было 
выделено.

1 Выполните команду меню Select ⇒ Inverse 
(Выделение ⇒ Ин версия). 

Хотя анимированная граница выделенной обла-
сти вокруг рамы картины не изменилась, обратите 
внимание, что такая же граница появилась и по 
краям изображения. Теперь выделено все изобра-
жение, за исключением портрета. При этом невы-
деленную область фотографии нельзя будет ре-
дактировать до тех пор, пока активна выделенная 
область.

2 Щелкните по кнопке Hue/Saturation (Цветовой тон/Насыщен-
ность) на панели Adjustments (Коррекция), чтобы добавить новый 
корректирующий слой . На панели Properties (Свойства) отобразят-
ся элементы управления для настройки цветового тона и насыщен-
ности.

� Совет. Сочета-
ния клавиш для этой 
команды, Ctrl+Shift+I 
(Windows) или 
Command+Shift+I 
(OS X), отображаются 
рядом с названием со-
ответствующего пункта 
в меню Select (Выде-
ление). В дальнейшем, 
чтобы инвертировать 
изображение, вы мо-
жете нажать соответ-
ствующее сочетание 
клавиш.

Selected
(editable)
area 

Unselected
(protected) 
area

A. Выделен-
ная (редак-
тируемая) 
область

Б. Невыде-
ленная (за-
щищенная) 
область
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3 На панели Properties (Свойства) установите флажок Colorize (Тони-
рование). Затем присвойте параметру Hue (Цветовой тон) значение 
200 для коррекции цвета в выделенной области.

Обои примут синий оттенок.




